
 
 

 

Page 1 

CES320022 

Acquire and Visually Present GIS Data Like a Pro in 
InfraWorks (and Civil 3D!) with Autodesk Connector 
for ArcGIS 
Shawn Cox 
MG.aec Technology Partners 
Design Technology Specialist - Civil 
 

 

Description 

Build on your existing Infraworks and Civil 3D knowledge and get more value from your AEC 
Collection! Learn how you can take advantage of the new Autodesk Connector for ArcGIS in 
Infraworks and Civil 3D to consume and visualize GIS shape information from connected 
ArcGIS Databases. See creative ways of using Infraworks styles and theming to present 
geospatial information to stakeholders and the public that you may not have thought of before. 
Where does the Autodesk Connector for ArcGIS get data from? How is it accessed for use 
within your organization? What can you do with it once you’ve got it? You might be a city 
planner, designer, technician, or a civil engineer working on a proposed capital improvement 
project. You might be a private industry land developer, or land-use planner, or civil designer 
getting ready to locate a new commercial or residential development. You could be planning a 
mine or an electrical substation. See new possibilities for cost-effective efficiency in the 
feasibility, design, and engineering phases of development. 
 

About the Speaker 

Shawn Cox is a Design Technology Specialist with MasterGraphics.aec where he serves clients 
in the Civil Engineering, Surveying, and Construction Industries. At MG.aec, Shawn helps 
clients gain the proficiency, efficiency, and confidence needed to compete in today’s fast-
changing AEC market. He holds a BA in Planning and Urban Policy from Western Washington 
University, Bellingham, Washington, and spent six years working in the civil engineering and 
land use planning industry. For the last 13 years, Shawn has specialized in Autodesk civil 
solutions consulting, technical sales, support, instructor-led training, technical writing, and CAD 
installations and deployments. He also presents regularly at industry conferences. This is his 
third Autodesk University but his first time presenting at AU. When not at work, Shawn enjoys 
spending time with his wife and family in and around their home in Spokane, Washington. 

Learning Objectives 

• Better understand powerful new ways to create connections to GIS data. 

• Internalize innovative functionality for consuming and presenting GIS data easily. 

• Enhance and Streamline existing techniques and workflows in Infraworks and C3D. 

• Consider new uses for GIS data in your projects, models, and drawings. 
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Introduction  

My hope for this class is to go beyond just showing you that there are new ways to load ArcGIS 
data into Infraworks and Civil 3D. Autodesk is already doing a fantastic job spreading that news 
and showing us where the buttons are. I have struggled at times myself to understand how to 
find and access the right GIS data when I need it, and how to “prepare it for use” for designers 
and stakeholders. Because I am not a GIS technician or GIS expert it was previously a mystery 
to me. So now that Autodesk and ESRI have partnered to make the physical connection 
process between the two worlds so incredibly easy, I want to show you what I have primarily 
learned by asking the ESRI folks a lot of questions, about how easy it can be to not only find the 
data that I’m after, but to store it and make it available to myself and others. So, yes, in this 
presentation I am going to show you where the buttons are in the Autodesk civil applications just 
in case you haven’t seen them yet, but I also want to take you behind the scenes a little bit and 
show you how you can find the data and prepare it for yourself on the other side in ArcGIS 
Online (and by extension, in ArcGIS Pro, although I’m not showcasing that interface here). And 
even if you aren’t going to have your own seat of ArcGIS at least you’ll know what’s going on 
over there and maybe you’ll be able to ask for what you need with a little bit more confidence, 
because you’ll know more about what is possible and have a better understanding of what goes 
into getting it for you. 
 
Beyond that, I’ll also be jumping back to Infraworks and Civil 3D and actually using the data 
there to give you some ideas on how you might configure connections to your own GIS data for 
future projects, hopefully in such a way as to encourage you to try things with GIS data you may 
not have considered before. 
 

Powerful new ways to create connections to GIS data 

So, the long and the short of it is that Autodesk and ESRI have partnered on this project to 
create what Autodesk is calling the Autodesk Connector for ArcGIS in their civil products. It 
will probably be added to some of the building products as well, eventually. It is available right 
now in Infraworks and Civil 3D. In this presentation I will be using the new tools that live in the 
civil products to illustrate their functionality. But I also want to show you what is possible “on the 
back end” so to speak. In the realm of the GIS Analyst. Whether you are planning to use GIS 
data in Infraworks, or in Civil 3D, or both, everything you are about to see starts with ArcGIS, 
either ArcGIS Online, or ArcGIS Pro, the desktop version of the application. We've got to have 
the right data to connect to and ArcGIS is where it all comes from. 
 
First off, hopefully us designers will usually be working with and relying on a real GIS Analyst. 
 
How do I make sure I’m getting the data I want, organized in the way I need it organized? The 
answer to this question is the GIS Analyst. If I have one of these types of experts on staff or at 
least accessible to my organization, my efficiency as a designer will be greatly increased. This is 
because ArcGIS is based on the sciences of geography, statistics, and computing (GIS 
technology itself). You could get a master’s degree or a doctorate in GIS. There is a lot to know 
about GIS and about ESRI software in particular and learning it all might not be the best use of 
your time as a designer or stakeholder. 
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Regardless, I am starting this presentation out by introducing you to the ArcGIS Online interface 
where I can show you a little bit more about these pre-processes with regard to your design 
work, so that you will have a better understanding of what is happening on the ArcGIS side of 
the equation. The things you learn here might even make it possible for you to set up basic data 
connections yourself that you can use as a designer or invested stakeholder in Infraworks or 
Civil 3D. 

What Do You Need to Know About ArcGIS Online and Pro? 
You’ll want to be aware that you need the right entitlements and permission to use the 
Autodesk Connector for ArcGIS. To connect to the data on the Infraworks or Civil 3D 
side of the equation, you need to have a purchased seat of ArcGIS Online or Pro that 
will allow you to be given the roles Creator and Publisher, or at least Editor, of data. To 
create the maps and content you will also need an appropriate ArcGIS seat type and 
similar roles and permissions. 
 
1. Sign into ArcGIS Online at www.arcgis.com (use your own credentials). 
2. Go to "<your name>” dropdown and choose "My Profile" to view the rights given by 

your organization's administrator based on seats available: 
a. Role should be: Publisher 
b. User Type should be: Creator 

The Save and Share buttons will not be available in the Map pane unless a Role of 
"Publisher" or higher are given by the admin, and you must be a User Type of “Creator” 
or higher to be a Publisher. This functionality in ArcGIS is also contingent on the type of 

http://www.arcgis.com/
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entitlement you’ve purchased from ESRI. It will often be the case that your company will 
have a GIS Analyst on staff who will have these credentials and entitlements while you 
as a designer might only be entitled and credentialled to use maps and connect to the 
data within them. If that is the case, the information you are learning in this class is more 
informational for you, to allow you a better understanding of how your GIS Analyst is 
setting things up for your use. 

User Type "Creator" with Role of "Publisher" can save and share maps (and access saved and shared 
data in Infraworks and Civil 3D). 

3. Create a new map: (Click "Map" tab, and then "New Map", and then "Create New Map". 
a. Fill in Map “Title” 
b. Choose "Save”. Save the new map as "SPOKANE 1" or whatever name you like. 
c. You must have at least one "Tag" (more is better) to search for the data using 

keyword searches in ArcGIS. 
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d. The "Summary" section is helpful later when the need to remember 
what the purpose of the map was arises. 

4. Select the “Share” button and check the boxes for who you would like to share your map 
with. 

 
5. Type in Spokane, WA, in the "Find address or place" value cell, or if you know where 

you are going, zoom in on Spokane, or the destination of your choice. 

6. Click the “Save” button again and save your location on the map to your saved map. 
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ArcGIS Data and Infraworks 

Finding Data and Saving it to an Online Map 
1. Find data by clicking on the “Add” button and choosing from several sources: 

 
2. If you Choose “Search for Layers” you will have six ways to add layers. 
3. Choose "Living Atlas" for national or world-wide data services hosted by ESRI. 
4. Search here with keywords like: 

• “USA Soils Map Units” 

• “FEMA Flood Hazard Areas” 

• “NOAA Survey Control Points” 

• "National Bridge Inventory" 
5. You won’t find data associated with local place names here because ESRI does not tag 

these geospatially generic kinds of hosted layers with local place names. 
6. Choose "ArcGIS Online" for data publicly shared (or "hosted") by users. Here we can 

search for data hosted and shared by our own organization, or publicly published data 
from other users, often municipalities: 

a. Search "Spokane" and notice the number of Layers available. 
b. Search "City of Spokane" and see that there are fewer ArcGIS Layers available. 
c. Search "Spokane water" to find water system related data quickly 
a. Add watermains to the map. 
b. Click on a water main onscreen to see data. 
c. Go to “Details” on the top left side of the interface. 
d. Click “Content” button down and to right diagonally from “Details” button. 
e. Hover over the grid icon and see that it is named “Show Table”. Click the icon. 
f. Look through the resulting table containing the water main attribute columns. 
g. If you save the map right now the Water Mains data will remain in the map and 

be available in connected Infraworks and Civil 3D models. 
 

Using the Data from an Online Map in Infraworks 
1. Go to Infraworks. Open the "Elm Strong Development" model or your own model of 

Spokane (or alternately, your own model of the area you are working in and collecting 
data in an ArcGIS online map for). 
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2. Find and click the "Autodesk Connector for ArcGIS source" button on the Content 

Panel of the Manage tab in the new Infraworks interface ribbon (version 20.1.62.0 or 
newer) dropdown (for importing locally saved Shape files). 

3. Find the “SPOKANE 1” Map (or your own map’s name) under "My Groups", or "My 
Content" (if you remembered to Save it and Share it to your Group in ArcGIS Online). 

4. Select the Map (whatever you named it when you created it a few minutes ago). 
5. See the "wMain" ArcGIS Layer is there. Click on the "Select feature type" dropdown 

and choose "Pipelines". 
6. Pick the "Add to my design project" button and see it come into Infraworks. 
7. Open the Data Sources dialog from the Content panel on the Manage tab of the 

Infraworks ribbon. 
8. Right-click on the “wMain” heading and choose “Configure”. 
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9. In the Data Source Configuration dialog box Configure “wMain” to be 3 feet below 
the surface (using the negative symbol to specify Z direction). 

 
10. Orbit around and under the model to see where the Water pipes ended up. 
11. It’s not design data, but it is context data for planning purposes. 

 

Finding Data on a Website 
Start in ArcGIS Online: 

Note: The data you need may not necessarily be shared publicly in its entirety in ArcGIS 
Online so sometimes it may be necessary to find it externally and manually add it to My 
Content in ArcGIS Online. 

1. Go to City of Spokane GIS web page (https://data-spokane.opendata.arcgis.com/). 
2. Scroll to the “Public Works section under “Explore Data Categories” 

https://data-spokane.opendata.arcgis.com/
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3. Scroll down and click “More Results”. 
4. Scroll all the way down and click on “Storm Water Sewer Gravity Main”. 
5. Click the Data button to see the data table and review the attribute fields 
6. Click the "Download" button. Download the "File Geodatabase" to the local machine 

(put it somewhere you can find it easily). 
7. Go back to ArcGIS Online and choose the "Home" drop-down and choose "Content" 
8. Choose "Add Item" button. Choose "From my computer". 

In resulting dialog box, click on "Choose File" button -> browse for GDB zip in the 
location where you saved it on your local machine. 

9. Under "Contents" choose "File Geodatabase". 
10. Notice Title self populates from filename. 
11. "Tags" are optional here, but very useful later when searching "My Content" (I highly 

recommend creating some). 
12. Finally, Pick "Add Item" button. 

Note: Whenever you can get a File Geodatabase, choose it over Shape Files. 
File Geodatabases usually have additional data the GIS Analyst that created the 
file has associated with it and have potentially more than one Feature Class in 
the same file (i.e. Points, Lines, Polylines all in one place). File Geodatabases 
are more “data rich”!). 

13. At this point, the program switches to a screen where it informs us that it is "Creating a 
Service". This “Service” will be available to us via our ArcGIS Online account and 
therefore will also be available to both Infraworks and Civil 3D via the Autodesk Data 
Connector for ArcGIS. 

14. On this page you can: 
a. "Add a brief summary about the item" 
b. "Edit Thumbnail" 
c. Add an in-depth "Description" 
d. Add "Terms of Use" and leave comments for team members or the public. 

Note: This is important if there are legal limits to how the data is to be 
used and you are publishing the data connection to a group, or to the 
public (at which point the data will be available to anybody on ArcGIS 
Online). Other users need to be aware of the legal limits of use. 

15. Choose "Open in Map Viewer" button and go back to the map. See that the Storm 
Sewer Gravity Mains data is added to your map. 
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16. I only downloaded the “Storm Sewer Gravity Mains“ geodatabase to my own computer 
and then uploaded it to ArcGIS to demonstrate how you can do this if you are ever in the 
situation where you can’t find a published service to the data you want already on 
ArcGIS Online, but you can find the data you want on a website in downloadable form 
(again Geodatabase files are among the most data rich sources, more data rich than 
Shape files alone, and are well suited for this task). To get the complete existing City of 
Spokane Storm Sewer Gravity system dataset loaded into Infraworks like I have in my 
demonstration use the previous 14 steps again to also add the other City of Spokane 
storm sewer geodatabases into your ArcGIS Online content, or more easily in this case, 
since Spokane publishes their data under the username “gisadmin_spokane”, you 
could simply click the “Details” tab in ArcGIS Online, click the “Content” tab, find the 
“Water Main” listing in the “SPOKANE 1“ map (or whatever you’ve named your own test 
map), right-click on the three-dot ellipsis button for the “Water Main“ heading and 
choose “Show Item Details” from the resulting right-click menu. 

17. This will take you to the user’s info page for the Water Main published item we used in 
today’s earlier (first) example, and from here you can simply click the user’s name (the 
“gisadmin_spokane” link) and after choosing “Items” in the resulting fly-out menu, you 
will be taken to the page where all of the user’s other published services are. Once on 
that page, which contains each published service in list form, find the other items that 
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make up the Storm Sewer Gravity system and add each item to the map. Once the items 
have appeared in the map, click the “Save” button. Now each of these items is saved in 
your map and can be accessed from that same map from within the data connectors in 
Infraworks and Civil 3D. Whichever way you decide to make the data available to 
yourself, in my demonstration I made the following items available for connection using 
one or the other of the procedures I just outlined: 

• Storm Water Manhole 

• Storm Water Inlet 

• Storm Water Outfall 
18. Next, bring these data sources into the Infraworks model: 

a. In Infraworks, open the “Elm Strong Development” model. 
b. In Infraworks, find and click the "Autodesk Connector for ArcGIS source" 

button on the Content Panel of the Manage tab in the new Infraworks interface 
ribbon. 

c. Notice all of the source headings but click on the "My Content" source. 
d. Click on the "swGravityMain" data source, click on the "Select feature type" 

dropdown, choose "Pipelines". 
e. Click the blue “Add to my design project” button. 
f. See the storm water gravity main data in the Infraworks model. 
g. If desired, configure the data by right-clicking on the subheading for the 

“swGravityMain” data source and choosing “Configure”. 
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h. You will see that you can take advantage of the fact that this data set has invert 
elevation attributes called “UpDepth” and “DownDepth”. And, if we put minus 
<negative> symbols in front of the UpDepth and DownDepth attribute names in 
the configuration dialog box the program will place each end of each pipe under 
the terrain surface at the correct elevation value populated by the attribute. We’re 
also setting the inside diameter size of each pipe in the “Size” area of the dialog 
box according to the “PipeDiam” attribute in both the X and Y directions. 

  
19. Whether adding the items to your Infraworks model from your “SPOKANE 1“ map, or 

from individual content items appearing in the Autodesk Connector for ArcGIS interface, 
depending on how you decided to get the data into your ArcGIS Online setup in step 16, 
next add in “swManhole” (as “Pipeline Connectors”) 

18. Add in “swInlet” (as “Pipeline Connectors”). 
19. Add in “swOutfall” (as “Pipeline Connectors”). 
20. Configure the “swManhole” data. Under "Size", select the “Geometry“ attribute for both 

the "Size X" and "Size Y" value cells, and then physically type in “-MhDepth“ in the 
"Height" value cell. Then click “Close & Refresh”. 

21. I didn’t configure the Inlets and Outfalls in this demonstration. Experiment with 
configuration with regard to these pipeline connectors if you’d like more practice. 
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Vetting Data Sources in ArcGIS and Theming the Data in Infraworks 
1. With the “SPOKANE 1” map open in ArcGIS Online, Click the dropdown arrow next to 

the “Add” tab/button at the top left of the screen. Choose “Search for Layers”. 

2. Click the search-source-type drop-down button (its current heading reflects the las 
choice you made when using this drop-down) and choose “ArcGIS Online” as the source 
for which to search for data. 

3. Type “Spokane zoning” into the search area. 
4. Pick the “planning – Zoning” choice published by our old friend “gisadmin_spokane” 

from the search results. Observe the expanded section containing the description of the 
published data (continued next page). 
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5. Either choose the little “+” button or the “Add to Map” button in the expanded section to 
add it to the map. 

6. In ArcGIS Online, zoom out in the map window to see the whole of the City of Spokane 
with the Zoning layer added. 

7. Click the “Details” button. Make sure the Content tab is also selected. Hover over the 
“planning – Zoning - Zoning” heading. Choose “Show Table” to see the data table and 
peruse the data. Take special note of the Description attribute column. This is the data 
we will use for Theming in Infraworks. 
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8. Hover over the “planning – Zoning - Zoning” heading again. This time choose 
“Change Style” to see the legend in the map window. Again, these are the descriptions 
we will be using for theming in Infraworks. 

 Note: understanding what’s in the data set is important to knowing if and how 
we use the data in our contextual model in Infraworks. 

9. If you’d like to change the fill colors of the legend, use the “Select a drawing style” 
options (optional – not necessary right now).  

 
10. Open Infraworks. Go to the Infraworks Home screen.  
11. Open the “AU SPOKANE“ model (see instructions at beginning of handout for gaining 

access to this model or create your own using Infraworks Model Builder). 
12. In Infraworks, find and click the "Autodesk Connector for ArcGIS source" button on 

the Content Panel of the Manage tab in the new Infraworks interface ribbon as before. 
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13. In resulting Autodesk Connector for ArcGIS interface click "My Content". Then select 
the “SPOKANE 1” source only, but don’t check mark it. Just select it by clicking on the 
thumbnail. Then put a check mark next to only the “Zoning” layer when the SPOKANE 1 
flyout opens. This will “check” the Spokane source automatically. 

14. Choose “Coverage Areas” in the “Select feature type” drop-down.  
15. Click the “Add to my design project” button at the bottom of the interface to add the 

zoning layer to the Infraworks model. The Autodesk Connector for ArcGIS will close as 
the layer is added to the model. 

16. In the main Infraworks interface, find and click the "Data Sources" button on the Content 
Panel of the Manage tab in the new Infraworks interface ribbon. 

17. In the resulting Data Sources dialog box, find the Zoning subheading, right-click and 
choose “Configure”. 

18. In the Configure dialog box set the Name value to “ZoneDesc”. 
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19. Create a theme by going to the Feature Themes button in the “Display” panel drop-

down on the Manage tab of the Infraworks ribbon. 

20. In the Feature Themes dialog box, click the green “+” button. 

 
21. In the Theme Properties dialog box, name the new theme “Zoning Descriptions”. 
22. Choose “Zoning” in the "Feature Class" drop-down to associate the Zoning data 

source we’ve added to our model with the theme. 
23. Choose “ZoneDesc” in the "Property" drop-down to associate the zoning descriptions 

attribute column with the coverage areas from our Zoning data source. 
24. Choose “Individual Values“ in the "Distribution" drop-down which will automatically 

divide the theme into 23 different values. This is the number of different zoning 
descriptions there are in the data set. 

In this figure red circles 
depict the values I’ve 
changed while theming the 
Zoning data source. 
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25. I chose “HSW CCW“ for the "Palette Type" and picked a green color for the “Color 
From” selection. 

26. I picked an orange color for the “Color To” selection. I found that these colors give a 
good set of distinct colors to the 23 different attributes we need to assign separate color 
values to than some of the others I’ve tried. Feel free to experiment if you’d like to try a 
different schema. 

 
27. After clicking “OK” in the Theme Properties dialog box, the model updates, the colors 

are applied to the coverage polygons and we can use the Feature Themes dialog as a 
legend as we explore the Infraworks context model. 
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28. Go to Model Explorer, right-click on “Zoning“ in the "Surface Layers" collection, choose 

"View in Data Table" to show tabular data. 

 
29. Pick a row, choose "Zoom to selected" to zoom in on zone and then show Properties 

tag value cell to see the zone description there. 

 

Analyzing Data Sources in ArcGIS and Displaying the Analysis in Infraworks 
 
The analysis for hot and cold spots for property sales in 2019 based on sale price example was 
complex. An experienced GIS Analyst helped me create the analysis in both ArcGIS Online and 
ArcGIS Pro. I am not going to go over the setup for the analysis in ArcGIS. I will say it was 
based off of a geodatabase dataset called “2019 Property Sales” that we found and 
downloaded from the Spokane County website and then added to ArcGIS in the same way I’ve 
described already in the section entitled “Finding Data on a Website”. 
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In Infraworks we added the feature as Building data so that we could use Roof Height to allow 
the data to appear like a bar graph within the 3-dimensional model. 
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ArcGIS Data and Civil 3D 

Connecting to ArcGIS Data in Civil 3D 
1. In Civil 3D 2020.1 open the drawing called “Elm Strong1.dwg”. 
2. Go to the Insert tab and choose the “Autodesk Connector for ArcGIS“ button from the 

ArcGIS panel. 

3. Type “N Elm St & W Strong Rd, Spokane, WA, 99208, USA” in the “Search by 
location” value cell. 

4. Zoom and Pan the window so that you can clearly see W Jay Ave on the north, N Elm St 
on the east, and W Strong Rd along the south side. 
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5. Choose the button to “Draw a rectangle to select an AOI”, and draw a rectangle 
around the full extents of the property. 

6. The left side of the screen will open exposing the available data sources. Click on the 
thumbnail for the “SPOKANE 1“ map and when the “SPOKANE 1“ Layers area expands 
out: 

a. Put a check next to “swOutfall”, pick “Structures” from the drop-down. 
b. Put a check next to “swManhle”, pick “Structures” from the drop-down. 
c. Put a check next to “swGravityMain”, pick “Gravity Pipes” from the drop-down. 
d. Put a check next to “swInlet”, pick “Structures” from the drop-down. 
e. Click the “Add to my design project” button to add these items to the Civil 3D 

drawing. 
7. When the Schema Mapping dialog box appears, notice that you get a separate tab for 

each type of gravity part you introduced from ArcGIS. You can change certain values 
(like Pipe and Structure diameters) on the fly. Don’t change anything here now. Just 
familiarize yourself with the way things are set up. 
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8. Check the Feature Settings in Civil 3D and notice that the default styles set there are the 
styles that are applied to the parts as they are created in the drawing 

9. Check the Prospector, under Pipe Networks to see that a new Civil 3D Pipe Network 
called “ArcGIS Network” is now listed. This is the network created from the connected 
data. It is a permanent set of objects in your drawing and the network can be renamed. 

 



 
 

 

Page 25 

10. Right click on the network and choose “Select” from the menu to highlight the network 
parts in the drawing window. 

 

Publishing Data to ArcGIS from Civil 3D 
We can also take intelligent design objects we’ve created in C3D and copy them directly into 
ArcGIS Online including much or all of the object data associated with them. In this way, 
accurate, data-rich, As-Built content from our design drawings can be submitted to 
municipalities for inclusion in their GIS systems. Or we can store the data in our own ArcGIS 
system and use it again in our own current or future projects. 
 
In the “ELM STRONG1“ drawing, we’ve got several Civil 3D design elements. There is an 
existing ground surface, and some roadway corridors and their surfaces that are turned off, 
many visible Parcel objects, a visible proposed storm water gravity Pipe Network, and a visible 
pond Feature Line for storm water detention pond grading. In this exercise, we will practice 
publishing the visible. 
 

1. Continue working in the “ELM STRONG1” drawing. 
2. Click the “Publish to ArcGIS” button on the Publish panel of the Output tab of the Civil 

3D ribbon. 
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3. In the “Publish to ArcGIS” dialog box, click the “Connect” button (or sign into your 
ArcGIS account if you aren’t already signed in).  

4. After connecting, the “Publish to ArcGIS” dialog box populates with any design 
elements in the drawing that can be published to ArcGIS. This includes Point Groups, 
Alignments, Feature Lines, Sites (and the Alignments Feature Lines and Parcels located 
within them), and Pipe Networks. Pressure Networks cannot yet be published to ArcGIS. 

5. In the “Publish to ArcGIS” dialog box, put a check in the “Parcels” check box under the 
“SITE 1 – PARCELS” Site, Also check the boxes next to “Feature Lines” in the “SITE 2 
– POND GRADING” site, and finally in the check box next to the “ELM STRONG 
STORM” Pipe Network (this is our new design network, not the existing network we 
recently brought in from ArcGIS). 

6. In the resulting “Publish to ArcGIS” wizard, accept the AOI on the “Area of Interest” 
page and click “Next”. 

7. On the “Layer Definition” page set the ArcGIS Categories as follows and click “Next”: 
a. Feature Lines = Polygon 
b. Parcels = Polygon 
c. Pipes = Line 
d. Structures = Point 

8. On the “Items Settings” page, create the service name “ES_PHASE2”, and create the 
following tags (the wizard page will not accept spaces so include the underscore): 

a. “Spokane” 
b. “Elm Strong Phase 2” 
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9. Under “Advanced Settings”, share with your organization and any groups within the 
organization that correlate to this test. 

10. In the “Publishing Location” page accept the “Publish to” location of “My Content” by 
clicking the blue “Publish” button 

Screen shots continue 
next page 
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11. Go back to your ArcGIS Online account interface and find the Content page. See that 

the C3D data is now available. 
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12. Add it to the map. 

 
13. Go to the “Details” tab with the “Content” tab toggled. Hover over the heading for “ES 

PHASE2 Pipe”. Choose “Show Table”. Observe the object data attributes carried to 
ArcGIS from Civil 3D for the Pipes. 

14. Hover over the “ES PHASE2 Structure” heading. Choose the “Show Table” icon. 
Observe the object data attributes carried to ArcGIS from Civil 3D for the Structures. 

15. Also observe the object data that came from Civil 3D for the Feature Line and the 
Parcels (same procedure). 
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Use Design Data Published to ArcGIS in another new Project or Drawing 
1. Use the “New“ command to start a new drawing from the “Autodesk Civil 3D (Imperial) 

NCS.dwt“ template that comes with Civil 3D. 
 

 
1. Set the new drawing to a coordinate system (or ArcGIS will not know where to place the 

geospatially located objects you want to share). 
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2. In Civil 3D, go back to the Insert tab and select the “Autodesk Connector for ArcGIS” 
button on the ArcGIS panel again and insert the “ES_PHASE2” content as shown here. 

3. Accept the defaults in the “Schema Mapping” dialog box for the gravity parts and 
observe the new data in the drawing file, ready to be expanded upon with new design 
elements, or changed. 
 
 

Make Design Changes in Autodesk Civil Products and Save Back to ArcGIS 
Note: Infraworks also contains Save Back functionality via the Connector for ArcGIS. 

1. In the new as-yet untitled drawing, change something noticeable about the geometry. 
2. Click “Data Source Manager” on the “ArcGIS” panel, “Input” tab in the Civil 3D ribbon. 
3. In the resulting “Data Source Manager” dialog box, only check “Pipe” and “Parcel” (i.e. 

uncheck “FeatureLine” and “Parcel”). 
4. Click the “Save Back” button. 
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5. Go back to ArcGIS Online. Refresh the “SPOKANE 1“ map. Observe the updated 
geometry.  

 
Note: you may have to move features up or down in the draw order to observe the 
things you want to see unobscured. 
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